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Lesson 7 
Introduction to Notes and Verify 

 
Welcome 
In this lesson, we will learn the purpose of the Notes application and 
also how to use the Verify application. The Verify application is 
sometimes referred to as the “calculator that does not calculate”. 
Verify does not give you the answer, but it will assist you in knowing 
whether or not your work is correct. 
 
Lesson Goals 

 To become comfortable using the Notes application 
 To understand how to use Verify to show work 
 To gain a general understanding of a parabola’s shape 
 To understand parent and children windows 
 

In Lesson 7, you will learn how to: 
 Write notes 
 Explore a parabola’s shape 
 Simplify numerical expressions using Verify 
 Simplify algebraic expressions using Verify 

 
Upon completion of this lesson, you will be able to 
answer the following questions: 

1. What application opens when we select the  button from the drop 
down button palette? 

2. What application opens when we select the  button from the drop 
down button palette? 

3. What happens when we click the  button in Verify? 
4. How do we change to the complex calculation mode when we are in 

the Verify application? 

 

Time required 
About 60 minutes. 
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Getting Started 
Most of this lesson will be hands on. We will work with the eActivity 
application and complete premade eActivities! 

 

PART I 
In this part, we will practice using the Notes application and also review a 
few topics from earlier lessons. Notes is a very simple text editor. As its 
name indicates, it is used to write notes, questions or answers.  
 
1. Inserting a Notes Application 

 

    
 

2. To Delete an Inserted Application 

      
 
 
 
 

a. Click inside the strip for 
Notes (within eActivity) 

b. Open the Edit menu and 
select Delete Line 

c. Another way to insert 
Notes is to use the 
toolbar button palette for 
inserting strips 

 
*You can delete any strip by 
clicking on it and selecting 
Edit/Delete Line 
 

a. Click m and then A 
b. Clear your window 

(select Edit/Clear All) 
c. Open the Insert menu 
d. Select Strip/Notes 
e. Type in some text 

(anything will do) 
 
*This is Notes. It is a simple 
text editor. 
 

Place 
focus 
here  

There is 
one button 
for each 
application 
listed in 
the 
Insert/Strip 
menu. 

Notes! 
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3. Working with Notes 
 

      
 
 

4. Exploring what happens to y=Ax^2 as A increases. 
Recall that the number in A’s location is called the leading coefficient. The 
leading coefficient is a very useful number. 

      
 
 
 
 
 
 
 

a. Insert a Notes strip 
b. Click inside the Notes 

window and type in 
what is showing in my 
Notes window 

c. Minimize the Notes 
window by clicking on 
the  button at the end 
of the strip 

d. Label the Notes strip 
“Parabola & Question” 

 
 

a. Type in y=x^2 below 
the Notes strip 

b. Insert a Graph strip 
c. Select y=x^2 and let go 
d. Drag the selection to the 

Graph window 
e. Change y=x^2 to 

y=3x^2 (change A to 3) 
f. Select and drag to the 

Graph window again 
g. Change y=3x^2 to 

y=4x^2 and graph it 
h. Experiment with the 

value in the A position 
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5. Having fun with the graph of y=Ax^2 as A changes.  
 

   
 
 

6. Continuing our exploration of y=Ax^2 as A increases. 
 

      
 

 
 
 
 
 
So, what does happen to a parabola when we increase the 
leading coefficient? But, first… 
 
 

a. Minimize the Graph 
window strip 

b. Click below the strip 
*We will store the list 
{1,2,3,4,5,6} in variable A 
c. Open the keyboard and 

select the 2D tab 

d. Press  and then type 
in the #’s 

e. Press W and input an A 
f. CHANGE to a math line 

and press EXE 
g. Our A now contains the 

list of numbers 
 

a. Now we need a Graph 
Editor window 

b. Click below your list and 
select Insert / Strip / 
Graph Editor 

c. Following y1 type in 
Ax^2 or A*x^2 and 
press EXE 

d. NOTE: I am using the 
ClassPad’s single variable 
for x. If you use the 
keyboard’s x, you need 
to input A*x^2  

e. Click the $button to 
see the graph. To re-
graph, click back in the 
Graph Editor window and 
click $ again 

 
 

Remember that you can press the 
Resize button on the icon panel to 
enlarge the window that has focus. 
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[Important] How do you get back to eActivity? 
 ANY window opened inside another can be closed by giving 

it focus and clicking on the  button in the upper right corner. 
You can also select Close from within the system menu ( ). 

            

What are parent and children windows in the programming 
world? 
 Parent Window Since we opened eActivity first, eActivity is the 

parent window. This means that it is always in the background, or until 

you select  or  from the icon panel. Notice the upper right x is 
grayed out when eActivity has focus. 

 Child Window When we insert another application within eActivity, 
you can think of it as a child of eActivity. Child windows can be closed. 

           

 

Or, selecting Close from 
the  menu while the 
Graph window has focus 
will close it and show 
eActivity again.  

Graph Editor was 
opened inside 
eActivity, so it is a 
child of eActivity. 

Tapping  on the 
Graph Editor toolbar 
opens the Graph 
window, a child of 
Graph Editor. 

If the upper right button 
looks like  you can click 
it to close the window 
with focus.  
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7. Answering our exploration of y=Ax^2 as A increases. 
 

  

     
 
 
 
PART I 
Practice Exercises 

Before beginning the practice exercises, open a word 
document, type in the following information and then save it 
as Lesson7 in your CASIO folder within My Documents:  

 Date: (enter today's date)  
 To: (put your instructor’s name here)  
 From: (put your name here)  
 Re: Lesson 7  

 
1. Please open the eActivity application and clear the window. 

2. Open the eActivity titled L7_PartI_a in the Lesson 7 folder. Don’t 
open L7_PartII_a by mistake! In this eActivity, you will learn another 
way of exploring parabolas with the ClassPad. 

3. Expand the Geometry strip and then change the leading coefficient from 
2 to a -2. Press EXE. 

4. With the Geometry window expanded, get a screen capture. Paste the 
screen capture in your Lesson7 document (under a title of PART I). 

5. Experiment with the leading coefficient by putting in different values 
(positive, negative, large and small values). You can reopen L7_PartI_a 
if you need to start fresh at any time. 

a. Now that eActivity is 
visible again, click  to 
expand (open) the 
Notes window. 

b. Type in an answer 
following the question. 

c. Explore more! 
d. Click inside the list and 

change it to: {-4,-3,-2, 
-1,0,1,2,3,4,5,6} 

e. Press EXE again to store 
the new list in A 

f. Scroll down and click on 
! to expand the Graph 
Editor  

g. Click the graph button 
 

Try changing  to 
 and graph again. 

Press Ctrl+R to resize 
the window. 

FUN!
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6. Expand the first Notes strip (labeled Question 1 Click). Type in an 
answer to the question using a complete sentence. 

7. With your Notes strip expanded and your answer showing, get a screen 
capture. Add two blank spaces following the first screen capture and 
then paste this one. 

8. Expand the second Notes strip (labeled Question 2 Click). Read the 
question and then re-open the Geometry window.  

9. Experiment with the constant at the end (the c value). Remember that 
the + and – keys will zoom your graph window in and out quickly. 

10. Expand the second Notes strip again (labeled Question 2 Click). Type 
in an answer to the question using a complete sentence. 

11. With your Notes strip expanded and your answer showing, get a screen 
capture. Add two blank spaces following the second screen capture and 
then paste this one. 

12. Save your work as an eActivity named L7_PartI_a_your initials here. 
For example, L7_PartI_a_dw. 

13. Open the next eActivity, L7_PartI_b. In this eActivity, you will work 
with another form for a parabola. 

14. Expand the Geometry strip and then change the 2 to a -1 and the 
ending 1 to 2. Press EXE. Your link should look similar to: 
y=3(x+1)^2+2 or y=3(x--1)^2+2.  

15. With the Geometry window expanded, get a screen capture. Paste the 
screen capture on the next line following the first three. 

16. Experiment with the numbers in the h position and k position by putting 
in different values (not too large, but try both positive and negative). 

17. Expand the Notes strip (labeled Question Click). Type in an answer to 
the question using a complete sentence. 

18. With your Notes strip expanded and your answer showing, get a screen 
capture. Add two blank spaces following the last screen capture and 
then paste this one. 

19. Save your work as an eActivity named L7_PartI_b_your initials here. 
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PART II 
In this part, you will learn how to use the Verify application. As you will see, 
this is a very useful application that will assist you in simplifying expressions 
without actually giving you the answer. Verify can be used in either the Main 
application or in eActivity.  
  
1. Inserting a Verify Application 

    
 

 
 
 

2. Adding Fractions with Verify 

    
 

 
 
 

a. Open eActivity and clear 
the window 

b. Open the Insert menu  
c. Select Strip / Verify 
d. Type 40 in the top box 

in the Verify window 
e. To see what happens, 

type 9*5 in the next box 
and press EXE 

f. Click OK and change 
9*5 to 8*5 and press 
EXE 

g. In the next box, factor 
40 to 2*4*5 and press 
EXE 

i. You can rewrite 40 as many times as you would like. Verify will let you know 
whether or not your input is equivalent to 40. 

a. Clear your Verify window 
by clicking the  button 

b. Using the 2D fraction, 
type in 1/6+5/8 and 
press EXE 

c. Drag 1/6+5/8 to the 
box on the next line 

d. Click just following the 
first fraction and click 
N; repeat for second 
fraction 

e. Add the numbers needed 
to create a common 
denominator of 24 and 
press EXE 

f. Continue until you reach 
19/24! 
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3. Factoring with Verify 

    
 

 
4. Factoring with Complex Numbers 

Recall that when we are working with complex numbers:  
 and . 

  

   
 
 

a. Clear your Verify window 
by clicking the  button 

b. Type in x^4 – 1 and 
press EXE 

c. In the next box, type in   
(x^2 + 1)(x^2 - 1) 
and press EXE 

d. In the next box, type in   
(x^2+1)(x -1)(x+1) 
and press EXE 

e. Can we factor again? 
f. Try: 
   (x+1)(x+1)(x-1)(x+1) 
g. Well, we tried. 

a. Do NOT clear your Verify 
window  

b. Change the last line to:  
     (x+i)(x-i)(x+1)(x-1)  

     using the imaginary unit i  
     from the soft keyboard or 

press Ctrl+i 
c. Non-Real Result (sorry) 
d. Click the down arrow 

($) on the toolbar and 
select the . This 
changes us to the 
Complex calculation 
mode. Thumbs up for 
complex numbers! 
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PART II  
Practice Exercises 

1. Please open the Main application ( ) and clear the window. 

2. Insert a Verify window by clicking the second down arrow on the toolbar 
and selecting  (Verify’s icon). 

3. Factor 60 completely inside Verify showing at least three lines. 

4. With your Verify window showing, get a screen capture and paste it 
into your Lesson 7 document (under a title of PART II).  

5. Return to eActivity and open the eActivity titled L7_PartII_a in the 
Lesson 7 folder. 

6. Near the top of the eActivity, there is a Notes strip that reviews Order of 
Operations for you. Please read it!  

7. Once you have reviewed the Order of Operations, expand the first Verify 
strip (labeled Exercise 1). Simplify the expression inside showing each 
step of your work.  

8. With your Verify strip labeled Exercise 1 open, get a screen capture. 
Add two blank spaces following the first screen capture and then paste 
this one. 

9. Expand the second Verify strip (labeled Exercise 2). Simplify the 
expression inside showing each step of your work.  

10. With your Verify strip labeled Exercise 2 open, get a screen capture. 
Add two blank spaces following the second screen capture and then 
paste this one. 

11. Return to the eActivity window and save your work as an eActivity 
named L7_PartII_a_your initials here. 

12. Open the eActivity titled L7_PartII_b in the Lesson 7 folder. 

13. Expand the first Verify strip (labeled Exercise 1). Simplify the 
expression inside showing each step of your work.  

14. With your Verify strip labeled Exercise 1 open, get a screen capture. 
If all your steps do not show in the half window, you can click Resize to 
maximize it. Paste the screen capture on the next line following the first 
three for this part. 

15. Expand the second Verify strip (labeled Exercise 2). Simplify the 
expression inside showing each step of your work.  

16. With your Verify strip labeled Exercise 2 open, get a screen capture. 
Add two blank spaces following the last screen capture and then paste 
this one. 

17. Save your work as an eActivity named L7_PartII_b_your initials here. 
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PART III 
There is no Part III for Lesson 7!! 
 
PART IV 

Reflection Exercises  
You have just completed the seventh lesson in ClassPad 101. Awesome! 
Please take a few moments to copy and paste the following three questions 
at the end of your Lesson 7 document and answer them. 

1. Approximately how long did it take you to complete this lesson? 

2. Which activity did you enjoy the most? 

3. Did you find any part of this activity difficult to follow? If so, which part? 
Also, how did you overcome the difficulty? 

 

Assessment 7: Introduction to Notes and Verify 

 Checkpoint:  Your word processed document, titled "Lesson7", 
should contain the following activities:  
1. Five screen captures from PART I. 
2. Five screen captures from PART II. 
3. Three reflection questions with answers from PART IV. 

 Submit your Lesson 7 document to your instructor for grading.  

 

 

 


